
GopherGolf
GopherGolf is the miniature golf game for Windows 95 and Macintosh. It's great fun for all ages. Now you and your family can enjoy 
the fun of putting through castles, windmills, pipes and water in the comfort of your own home. Watch out for that pesky gopher, You 
never know where he will pop up next.

Play the courses included in this package or create your own courses with the built in editor. You can also play courses created by 
other registered users.

GopherGolf has been available on the Macintosh for a while. Here is what some of the critics have said about it.

Inside Mac Games says 
 "Despite two great golf simulations that were released this summer, this is the golf game I have been waiting for."
 "I can't stress enough how great this game is when friends or family are over."
 "The controls are simple enough for just about anyone."

Chosen as "Shareware Star of the Month" by MacFormat magazine. 
They said 
 "Forget playing tournaments in PGA Tour or Links Pro, the only game you need is right here."
 "The author has spent ages producing one of the best pieces of I've seen." 
 "This will be the best $15 you've ever spent."

Legal Section

B&B Software offers no warranties, expressed or implied.
We have worked very hard to try to keep programs bug-free but it is impossible to eliminate all errors from software products. This 
program is provided as-is, use at your own risk.

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or consequential damages, some 
limitation or exclusion may not apply to you.

Protected and copyright © 1994-96 by Bob Mancarella. All rights reserved. GopherGolf is not public domain.

Commercial distribution, as is distribution in exchange for compensation or any other consideration, except that acquisition of 
download time in exchange for uploading this program onto electronic bulletin boards is allowed.
Limited permission is provided for person-to-person distribution where no compensation or any other consideration passes.
B&B Software reserves the right to restrict or withdraw permission at any time, for any reason, from any group or persons.
All copies must be complete and unaltered.

Distribution of registration number under any circumstances is a violation of the copyright and is violation of federal copyright laws.



Contacting B&B Software
Mail:
B&B Software
96 Highland Street
Portsmouth, NH 03801

Phone:
Orders from US call toll free 800-784-1158
Customer support or orders from outside of the US 603- 431-7421 
Office hours are Monday through Friday between 9:00 AM and 5:00 PM Eastern Time.

Email:
BandB@pobox.com

Fax:
603-436-7984

Web Site
http://www.pobox.com/~bandb/



Web Site
Visit our web site. We are located at http://www.pobox.com/~bandb/.

You can download the latest version of GopherGolf and other GopherGolf courses created by registered users. If you have created 
a course you would like to share email it to us at BandB@pobox.com. 

Check out our other games and scenarios too.

Notes about sending courses:

 The file should be zipped.
 Make sure the course is really a course and not a saved game. The saved game files have an icon with a little sheet of paper in the

middle. The courses don't.
 Give your course, or group of courses, a unique name so other people can recognize it. 



Courses
GopherGolf comes with 5 courses. There are lots of other courses available on our web site. 

If you create a course you want to share with the world email it to us and we will post it on our site. 



Ordering Information
This version of GopherGolf is a demo. It will allow you to play the first three holes of the courses. You can use the editor but you can
not save your course changes. To be able to play all 18 holes per course and edit courses you need to register.

You can register your copy of GopherGolf by phone, mail, email or through CompuServe's Software Registration. You will receive a 
registration number that lets you access all options of GopherGolf. At this time we are able to offer the game to you for only $15.00 
for just a registration number or $20.00 if you also want a disk sent to you.

A large amount of effort has gone into making GopherGolf a great game. We believe it is very high quality and the registration fee is 
quite reasonable. Please support our shareware efforts by registering your software.

When you order please make sure you specify either the Windows 95 or Macintosh version.

If ordering by phone call toll free 800-784-1158 outside the US call 603-431-7421. If you wish to order in any other way the first thing
to do is fill out the appropriate information on the order form that comes up when you start the game. Click the Create File button. 
This will create the order form with your information on it. You can now print and mail it or email it.

By Phone:
For orders only call toll free 800-784-1158 from US.
Customer support or orders from outside of the US 603- 431-7421. 
Office hours are Monday through Friday between 9:00 AM and 5:00 PM Eastern Time.
You must use a credit card to order by phone. Make sure you have your credit card information and call one of the numbers above. 
You can receive your registration number instantly. We currently accept VISA, MasterCard, American Express and Discover.

Online:
You must use a credit card to order online. To order this way go to our web site. Once there go to the GopherGolf page and click on 
the Register button. Fill out the registration form and click on Submit.
http://www.pobox.com/~bandb/

By Email:
You must use a credit card to order by email. Send the order form you created, with your credit card information filled out, to the 
email address below. Allow one to two days for your registration to be emailed back to you.
BandB@pobox.com

By Fax:
You must use a credit card to order by fax. Fax the order form you created, with your credit card information filled out, to 603-436-
7984.

By SWREG:
CompuServe has a facility they call SWREG which is short for Shareware Registration. This service will take your information from 
you and forward it to us. The registration fee will be added to your CompuServe bill. You can only order the registration number 
through SWREG. You can not order the disk this way. To order through CompuServe's SWREG facility type GO SWREG while on 
CompuServe. Follow the instructions. You will be asked for the software Registration ID. Find GopherGolf Win95. Allow two to three 
days for the registration number to be emailed back to you. Make sure you specify the Registration ID for Windows 95 not the 
Macintosh version.

By Mail:
If ordering from the United States you can mail your fee in cash, check or money order. If you are ordering from outside the United 
States you must mail your fee in cash, postal money order or bank check from a US bank. Do not send bank checks from foreign 
banks. Most foreign banks charge up to $50 to cash their bank checks in the US. Print out the filled in order form and mail it along 
with the registration fee to the address below.
B&B Software
96 Highland Street
Portsmouth, NH 03801



Playing
A. Starting the game

To start GopherGolf double-click on the GopherGolf icon. From the file menu choose Open. Open any of the courses listed. You can 
also double click on a course to open it.

A dialog box appears. Enter the names of the people playing. Don’t skip player entry boxes. If there are two people playing the 
Player 1 and Player 2 boxes should be filled in. Next you can choose to play in practice mode or in competition mode. 

Practice Mode
In practice mode you can jump around on the course to and from any holes you wish. You can replay holes if you like. In competition
mode you must follow the course in the order it was designed. In practice mode your final scores will not be eligible to be entered 
into the course Leader Board (a record of the ten lowest scores for the particular course). 

Competition Mode
In competition mode there is an stroke limit per hole which is set by the course designer. The maximum strokes per hole is stated on
the bottom of the Player's dialog.    If you click on the Practice or Competition button without filling in any players the game assumes 
you want to play with only one person and it uses "Me" as the player name.

B. Putting

The ball is placed on the tee area. The color of the ball changes when    players change turns. Each player has a different color ball. 
Each player must complete the hole before the next player can begin. The putter is placed directly below the ball and appears as a 
small, thick line.

The player who got the lowest score on the previous hole goes first. Be sure to check the color or pattern of the ball to see who 
should be putting. 

You can have two keys assigned to every action. For example you could have the "x'    and the "Keyboard 4" key turn the putter 
clockwise. This helps for when more than one person is playing. To view or edit the key assignments choose Controls... from the 
Game menu. To change the assignments click on one of the buttons to the right of the action you want to assign. When the correct 
button is highlighted press the appropriate key.

Key Actions:
Left 90 Degrees Turns the putter 90 degrees clockwise
Left Quickly Turns the putter clockwise quickly(5 degrees at a time)
Left Slowly Turns the putter clockwise slowly(1 degree at a time)
Right 90 Degrees Turns the putter 90 degrees counter clockwise
Right Quickly Turns the putter counter clockwise quickly(5 degrees at a time)
Right Slowly Turns the putter counter clockwise slowly(1 degree at a time)
Flip 180 Degrees Moves the putter to the opposite side of the ball
Swing Swings the putter(see below for more detail)
Show Slopes Shows the slope values for any slopes on the hole(see below for more detail)

IMPORTANT NOTE: If the course you are playing was designed incorrectly the ball may go into an infinite loop and never stop. If it 
looks like the ball is doing this hit the ‘q’ key. This will stop it wherever it is.

You can also use the mouse to putt. To turn mouse control on and off go to the Preferences screen. This will change the cursor to a 
putter. To aim the putter just move the cursor behind the ball where you want to hit it. You can use the mouse button to swing.

When the putter is placed use one of the Swing keys to hit the ball. Holding the Swing key will draw the putter back. When the back 
swing is where you want it release the space bar or arrow key. This moves the putter back towards the ball striking it. A larger back 
swing will cause the ball to be hit harder. The putter has a maximum back swing point. If it reaches this point the putter waits for you 
to release the button to begin it's swing. The power indicator located below    the score card also indicates how hard your swing is.
To cancel your shot hit the Swing key again after the stroke starts.

C. Hazards

The two objects that need a little explaining are water and slopes. Water areas are similar to a small canal in real miniature golf. The
water is lower than the playing surface. If the ball is traveling at a sufficient speed it will travel right over the water. If the speed is too
low the ball will fall down into the water. If this happens the ball is placed at the point where it started over the water and a one 
stroke penalty is added to your score.

Slopes are slanted areas of the playing field. The lighter areas of the slope are "higher" than the darker areas . The ball will be 
“pulled” from the lighter areas to the darker areas. The slopes have a cumulative effect. Two slopes with the same direction would 
represent a longer slope . The slopes have an incline factor of between one and ten. One is the flattest slope and ten is the 
steepest. To see the slope factor before you hit the ball, hold down the slope key (‘s’ is the default). This will show a number at the 
center of all the slope regions and an arrow showing the slope's direction. This number represents the slope factor for that particular 



slope area. 10 is the steepest slope, 1 is the smallest.

D. Gopher

The gopher is a pesky rodent that pops up randomly on the course. If you hit the gopher one stroke is taken off your score. If your 
ball rolls into a gopher hole you get a one stroke penalty, this can only happen if the gopher is no longer in the hole. You can control 
how often the gopher pops up and how long he stays up by selecting the gopher menu item in the Game menu.



Menus
A. File

Open...: Used to open a new course when no other course is opened.
Save: Save the current game to disk.
Save as...: Saves the current game with a new name.
Close: Closes the current course.
Quit: Quits GopherGolf.

B. Hole

This menu is only available in practice mode. The hole that you are on will show a check mark next to it. To go to a different hole 
select the number of the hole you want to go to. You can also select First, Previous, Next and Last holes on the course.

C. Game

Reset: This item clears all the scores and returns to the first hole of the course.
Preferences...: Brings up the preferences dialog. See below for details.
Controls...: Brings up the Key Preferences dialog where you can assign keys to different actions. You can also select mouse control.
Gopher...: This sets the gopher parameters. See 2.D. above.
Leader Board: Shows the Leader Board for the current course.
Clear LB: Clears the Leader Board. This can not be undone.
Register: To give full access to all GopherGolf functions you need to register your copy, see above. When you get a Serial number 
to register your copy this menu item will allow you to enter it into the system.
Info: This gives you information about the game and how to register. You can also click on the Order Form button to create an order 
form

Preferences:

Sound On: Selecting Sound On turns the sound on and off.
Color Scores: If this is checked the scores will be in color on color systems. Below par in blue, par in black, above par in red. If it is 
not checked the scores are all in black.
Mouse control: If checked    the mouse can be used to putt.
Next Player Window: In multiplayer mode this turns the "Next player: Player name" window on and off.



Editing courses
1. Introduction

If you have not registered, the edit mode is fully functional except it will not allow you to save courses.

The edit mode allows you to create your own GopherGolf courses. You can alter courses that came with the package or you can 
create your own from scratch.

2. Starting

To enter edit mode select Edit Course from the File menu. Choose Save as... from the File menu and give your new course a name. 
This will leave the original course unchanged. If you want to create a new course choose New from the Course menu.

Work areas

The GopherGolf edit mode has two work areas, The course area and the palette area. 

A. Course area

The course is created in the course area. It will appear exactly the same in game mode as it does in edit mode. The course area is 
located on the left side of the screen.

B. Palette area

The palette area is where you get all the pieces that you need to build your course. This section is not shown in    game mode. The 
palette area has multiple pages. To move to a different page click on the pointing hands at the top of the palette area. Each page 
contains different pieces that you can use on your course.    The other two icons at the top of the palette area are the blank and the 
outline icons. The blank icon (left) will clear the course area of all objects for the hole you are working on. The outline icon (right) 
clears the course area and creates the biggest rectangle border allowed on your monitor size.

There are two types of things on the palette you can use to create your course, grid pieces and object pieces.

Grid pieces

The base of the course is made up of the red walls. These are called grid pieces. The first pages of the palette consist of grid 
pieces. They align to a grid in the course area. The grid is ten by ten. To view the grid select Grid from the View menu. This grid can 
be hidden again by selecting Grid again. The grid can be visible or not visible but the grid is always active. 

To move grid pieces from the palette to the course area click on the piece you want to add to your course and drag it onto the 
course area. Once on the course area you can move it by clicking on it again and dragging it to a new location. If you hold down the 
Ctrl key while dragging a piece already on the grid the piece is copied and put at the new location. Left mouse dragging moves a 
piece, right mouse copies it.

Sometimes placing the grid pieces on the grid is a little tricky (especially when placing diagonal pieces). Try toggling the grid view on
to see exactly where the pieces will go when you place them.

Grid pieces become selected when you click on them. When selected you can move them one grid space at a time by using the 
arrow    keys. If you hit the Delete key the selected grid piece will be deleted.

There are some special grid pieces that don't have walls on them. They are for landscaping only. Normally these would be placed 
outside the playing area. They can be placed anywhere on the hole but they will not effect the ball at all.

Object pieces

Object pieces are on the palette pages after the grid pages. Objects are tubes, holes, buildings, slopes, water and bridges. These 
items don't align to the grid. They can be placed anywhere on the course area. 

Object pieces become selected when you click on them. When selected you can move them one pixel at a time by using the arrow 
keys. If you hit the Delete key the selected object piece will be deleted.

Each object behaves differently and has some rules applied to its use. These will be covered next.

A. Tee and hole

These objects are obvious. They must be included in every hole.

B. Tubes



Tubes are simple objects. The ball enters one side and exits the other. Tubes that loop must be entered with sufficient speed or the 
ball will exit out the same side it entered. The only rule for tubes is to make sure there is at least 1/4 inch between any openings and
any other objects except slopes. This means you can't make a longer tube by connecting them end to end. Leave the 1/4 inch 
between them or you will get unusual results.

C. Water

Water objects are special. They, along with slopes, are the only objects that can overlap each other or be overlapped by other 
objects. Water objects should not be placed within 1/4 inch of any ball exits. This includes tube, building and hole exits. The ball 
must be traveling at a sufficient rate of speed to get over the water.    If more than one water object are clumped together the ball 
must maintain this minimum speed at all times while it is over the objects.

D. Regular castle

The regular castle is pretty simple. The ball enters through one of its doors and has a 50/50 chance of exiting from either of the 
other doors. As with tubes, the doors of the castle should have a minimum clearance of 1/4 inch from all other objects except slopes.

E. Pyramid

A pyramid acts like a regular castle except when a ball enters one of its doors it will always exit from the door on the opposite side. 
Again the doors of the pyramid should have a minimum clearance of 1/4 inch from all other objects except slopes.

F. Tunnel

The tunnel (next to the water object) has two parts. When you place it on the course area the second part becomes visible. The 
second part is an exit. The ball enters the tunnel and exits through the exit. The exit must have the same minimum clearance as 
other object exits. You can only place one tunnel per hole. The tunnel object has other parameters. You can set the maximum exit 
angle, minimum exit speed and maximum exit speed. Once a tunnel is placed on the course area two menu items in the Object 
menu become available. The first, Tunnel settings, brings up a dialog to let you alter the attributes. You can also get to this dialog 
box by double clicking the tunnel object.    The second menu item is Tunnel direction which allows you to rotate the tunnel exit to the 
direction you want. The exit angle is random from zero to the value you set as its maximum. Zero being straight out the tunnel exit. 
The maximum angle is measured from this center line in the positive and negative direction (see Figure 1).    If the minimum and 
maximum exit speeds are equal the ball will always exit the tunnel at that speed.    You have to be a little careful placing the exit. If 
you experiment you can make the ball go from the exit back into the tunnel again. Yes, you can break the laws of physics.

Figure 1

G. Bridge

The bridge is another simple object that acts as you would expect. The bridge is arched so the surface slopes up in the middle. The 
ball can not pass under the bridge. The slope of the bridge can not be changed.

H. Windmill

The windmill is a special object type called a mover. The vanes of the windmill move in real time as you play GopherGolf. The same 
clearance should be maintained in front of both openings of the windmill, 1/4 inch. When you place a windmill on the course area the
Mover settings item in the Object menu becomes available. Selecting this menu item brings up a dialog box that allows you to set 
the speed of the windmill between one and ten. One is the slowest setting and ten is the fastest. Another way to make the dialog box
come up is to double click on the windmill. You are allowed one mover per hole.

I. Moving castle

The moving castle is another mover object. The drawbridge of the castle opens and closes. The ball can only get through when the 
drawbridge is completely down and not moving. The same restriction as the windmill apply to the castle and there is one more. You 
must leave a clearance space in front of the drawbridge itself too. When you place a moving castle on the course area the Mover 
settings item in the Object menu becomes available. Selecting this menu item brings up a dialog box that allows you to set the 
speed of the moving castle between one and ten. One is the slowest setting and ten is the fastest. Another way to make the dialog 
box come up is to double click on the moving castle. You are allowed one mover per hole. You can put water or slopes under the 
drawbridge.

J. Signs



Signs allow you to enter text into them. You can put anything you want in them, hole names, par, etc. When you place a sign on the 
course area the Sign text menu item in the Object menu becomes available. Selecting this item brings up a dialog box that lets you 
enter the text. You can also double-click on the sign to get the dialog box. You can have only one sign per hole. The sign does not 
effect the way the ball moves at all.

K. Slopes

The last group of objects are the slopes. The lighter part of the slope is "higher" than the darker part. The slopes have an attribute 
called the slope factor. This is a number between one and ten. One is the "flattest" and ten is the "steepest." Since there can be 
more than one slope on each hole you must select the slope by clicking on it to change its slope factor. When a slope is selected the
Slope settings menu item in the Object menu is available. This menu item brings up a dialog box allowing you to change the slope 
factor for the selected slope. You can also get this dialog box by double clicking on the slope object you want to alter. Usually it is a 
good idea to leave a little space between down slopes and walls (see Figure 2).

Figure 2

Hierarchy

The objects on the course can be moved on top of all other objects by selecting the object and choosing Move to front from the 
Object menu. To move the object to the back choose Move to back from the object menu. The grid pieces are always in the 
background. The tee and hole are always the front most objects.



Edit menus
A. Course

Course Max Strokes: Lets you enter a maximum number of strokes per hole in competition mode.
Hole Par: Assigns a par value for the hole you are editing.
New: Creates a new course.
Save: Saves the current course to disk.
Save as...: Saves the current course with a new name.

B. View

Grid: Shows or hides the grid.

C. Object

Move to front: Moves the currently selected object on top of all other objects.
Move to back: Moves the currently selected object beneath all other objects.
Tunnel settings: Lets you change the settings if there is a tunnel on the current hole.
Tunnel direction: Sets the direction of the tunnel exit if there is one on the current hole.
Mover settings: Sets the speed of the mover object if there is one on the current hole.
Slope Settings: Sets the slope factor for the selected slope object.
Sign text: Lets you enter text into a sign if there is one on the current hole.




